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n Chapter 1 Getting Started

Start here: Getting the most out of this guide

Start here: Getting the most out of this guide

To get started:

1. Read through Chapter 1 to become familiar with your
installation options.

See Chapter 2 for general installation requirements.
See Chapter 3 for pre-installation instructions.
See Chapter 4 for installation instructions.

See Chapter 5 for post-installation instructions.

o o k0 Dn

See Appendix 6, Troubleshooting the Installation for
troubleshooting instructions.

7. See Appendix 7, Glossary of Terms, for a definition of terms
used frequently in this manual.

After you have read the applicable chapters in this guide and are
installing your software, refer to the GeneMapper® ID-X Software
Administrator’s Guide for information on configuring the
GeneMapper® ID-X Software administrative features and electronic
data chain of custody systems.
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Installation options

Installation options

Installation options for the GeneMapper® ID-X Software are based
on:
+ The Windows® 7 operating system installed (32-bit or 64-bit)

+ The GeneMapper® ID or GeneMapper® ID-X Software
currently installed

* Your database-sharing requirements.

You can either install a fi// version of the software, which consists of
both the GeneMapper /D-X software and the database, or you can
install a client version of the software, which consists only of the
GeneMapper ID-X software. The full version on a computer can
function as the database host for the client. Multiple clients can
connect to the same database through a network connection for easy
data sharing.

New full or client installations

A new full or client installation requires a computer with
Windows® 7 64-bit operating system.

When you start the software for the first time, you must enter the
registration code provided with the new software.

Upgrade full or client installations

An upgrade full or client installation requires a computer with
Windows® 7 64-bit operating system.

Before installing the new software, you must export data from the
host computer, then uninstall the current software from both host and
client computers.

During the installation, you must enter the registration code for your
current version of software.

When you start the new software for the first time, you must enter
the registration code provided with the new software.
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Chapter 1 Getting Started
Installation options

Is the

GeneMapper® ID-X NO | Perform a new

Software installed > f.uII or clllent

on the computer? installation

YES

Export* projects, Manually uninstall the Perform a

analysis methods, and » GeneMapper® ID-X » full or client

size standards Software installation

*Use GeneMapper ID-X Manager to export.

Database backup files (.dmp) from an older
version of software cannot be restored to a
newer version of software.
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Full installation computer requirements

Full installation computer requirements

Requirements

Required time for
full installation

Table 2 shows the recommended computer configurations for a new
full installation (the GeneMapper® ID-X Software and database).

Note: To install the GeneMapper /D-X software, you need a local
user account with administrative privileges. You can run the
computer on regional settings but you need an English Operating

System.

Table 2 Computer requirements for a new full installation

Component

Configuration

IMPORTANT! Avoid installing the software on a computer with other
Oracle® or SQLPIlus applications and clients. If you must run other
applications, install GeneMapper ID-X first.

Computer
and operating
system 64-bit

Intel® Core™ i3-3240 processor, 3.4 GHz (or newer)
8GB of RAM

10 GB free disk space

20/48X IDE CD-ROM

10/100 NIC with RWU (internal)

Windows® 7 64-bit operating system (SP1)

Monitor 1024 x 768 pixel resolution

19-inch color monitor
Ethernet Network card for database installation
Capability TCP/IP must be installed before database

installation

Note: GeneMapper® ID-X software is validated to run on Intel®
Core"™ 17-4810MQ computers.

The amount of time required to perform a full installation is
approximately 1 hour, depending on the speed of the computer.
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Client installation computer requirements

Client installation computer requirements

Requirements

Required time for
client Installation

Optimizing
computer
performance

The recommended computer configuration for a client installation
(GeneMapper® ID-X Software only) is the same as the requirements
for a full installation shown in Table 2.

Note: To log in to the GeneMapper /D-X software, you need a local
user account with administrative privileges. For sites outside the
U.S., you may need to change regional settings to U.S. settings
following software installation.

The amount of time required to perform a client installation is
approximately 15 minutes.

For recommendations on the number of client connections to use per
host to optimize computer performance, contact us.
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Veerifying your computer setup

Verifying your computer setup
1. Click @ , right-click Computer, then select Properties.

View basic information about your computer

Windows edition

Operating system

Windows 7 Enterprise (OS)
Copyright © 2009 Microsoft Corporation. All rights reserved, Latest Service
. a 1
S),st:ﬂme et Pack installed
Manufacturer Thermo Fisher Scientific .
Rating: e Microprocessor
1530 s Experience Index type and Speed
Processor: Intel(R) Core(TM) i7-4600U CPU @ 2.10GHz 2.70 GH=
Installed memory (RAM):  16.0 GB Installed memory
System type: G4-bit Operating System
Pen and Touch: Mo Pen or Touch Input is available for this Displas: SyStem type

Thermo Fisher Scientific support

Phone number: 1.566.643.0360
Support hours: 24x7
Website: Online support

Computer name, domain, and workgroup settings
Computer name: BEDLESCAMI2
Full computer name: BEDLEECAMI2.ads.invitrogen.net
Computer description:

Domain: ads.invitrogen.net
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Analyzers and compatible software

Analyzers and compatible software

Instrumentation Table 3 lists Applied Biosystems® Genetic Analyzer instruments and
the corresponding Data Collection and operating system software
that are supported by the GeneMapper® ID-X Software

Table 3 Genetic analyzers and compatible software

Genetic Analysis Instrument Data Collection Software

3500 Data Collection v1.0,
Applied Biosystems® v2.0, or v3.0

Eé_’ 3500 Series Genetic
' . Analyzer
310 Data Collection v3.0 or

E E= 310 Genetic Analyzer V3.1

3130/3130x/ Data Collection
E h ] Applied Biosystems® v3.0 orv4.0

31xx Genetic Analyzer

3730 Data Collection v3.0 or
i | Applied Biosystems® v4.0
3 3730 Genetic Analyzer¥

F The 3730 Genetic Analyzer does not include the 3730x/ 96-capillary
configuration. The 48-capillary configuration is validated for analysis of
data generated from Identifiler® kits using single-source samples only.
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Analyzers and compatible software
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m Chapter 3 Performing Pre-Installation Procedures

Overview

Overview

Before installing GeneMapper /D-X software on computers that have
an earlier version of software installed, you must export the data
objects (projects, analysis methods, etc.) as a means of backing up
the data, then uninstall the existing software.

Check user access

12

You must log on to the local computer using a local account with
administrator privileges (read, write, and execute [rwx]
permissions). The local computer is typically identified in the log in
dialog box by the text “(this computer)” after the computer name

A local computer account may be different from the account you
normally use to log in to the computer. The local account:

¢ Can not include network domain policies that restrict access to
the install drive of the local computer account.

¢ Can not restrict access to operating system firewall or other
security configurations.
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Check user access

Check Local status

1. Select @) » Control Panel » User Accounts. Click Configure
advanced user profile properties.

OQ |3’4 <« All Control Panel Ikems » User Accounts - | s | | Search Control Panel 0 |
@

Control Panel Home
Make changes to your user account

Manage your credentials
Change your password

Create a password reset disk ini
e Remove your password Adml_ms'“
Link online IDs . Administr...
Change your picture Password ...

Manage your file encryption
certificate

Configure advanced user ';‘E' Manage ancther account

profile properties ) Change User Account Control settings

Change my environment
variables

See also

'EE' Parental Controls

2. Select your local user account and ensure that the Type is Local.
Administratars Properties @
General

% Adminizstrators

Description: Adminiztrators have complete and urrestricted access
to the computer/domain

Members:

& sBService

A s drmiriistrator
B INSTR-ADMIN

ai
q _i}" Mylocalbcoount™
il
Changes to a uzer's group membership

Add... Femove are not effective until the nest time the
uzer logs on.

[ QK ] [ Cancel Apply
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Check user access

Check Administrator privileges

1. Right-click My Computer, then select Manage.

2. In the Computer Management dialog box, click Local Users
' and Groups, then double-click Groups.
E'é'. Computer Management EI@

File Action ‘iew Help
L2 AReal e NETN 7|
A Computer Management (Local
a [J} System Toals = Local User., &
3 @ Task Scheduler F g oy

» [2] EventWiewer \ . e More .. b
s Shared Folders

i+ | Local Users and Groups )

Marme Actions

= Device Manager
4 (=5 Storage
=f Disk Managernent
» Ty Services and Applications

4 | i N i b

3. Double-click Administrators. Ensure that your local account is
listed in the Administrators group.

Administratars Properties @
General

% Adminizstrators

Description: Adminiztrators have complete and urrestricted access
to the computer/domain

Members:

& sBService
A s drmiriistrator
B INSTR-ADMIN

ai
(B MyLocalbeoounty
Changes to a uzer's group membership

Add... Femove are not effective until the nest time the
uzer logs on.
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Modify antivirus, firewall, and network computer settings

Modify antivirus, firewall, and network computer
settings

1. Disable Antivirus software (including anti-malware software)
before the installation.

2. Disable Firewalls before the installation.

3. Disable all network connections before the installation: Go to
Control Panel » Network and Sharing center. Double-click a
connection, then select Disable.

4. Disable all virtual network adapters are disabled (refer to
manufacturer documentation for instructions).

Export data objects and settings from the current
version of GeneMapper® ID-X Software

¢ Computers running a full version of GeneMapper® ID-X
Software (contains the database) or GeneMapper® ID
Software v3.2: Export the data objects or settings you would
like to restore after upgrade

— Analyzed projects, analysis methods, plot settings, etc.).

— Profiles from the Profile Manager (v1.5 software supports
import of text files containing profiles)

For information, refer to the GeneMapper® ID-X Software
online help.

e Computers running a client version of GeneMapper® ID-X
Software: Export is not required.

GeneMapper® ID-X Software v1.5 Installation Guide 15
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Uninstall GeneMapper® ID-X Software or Oracle® software

Uninstall GeneMapper® ID-X Software or Oracle®

software

Uninstall GeneMapper® ID-X Software, any other programs that use
Oracle databases, and any existing versions of Oracle databases,
whether Applied Biosystems products or products from other
companies. Go to Start » Control Panel » Add or Remove Programs.

After uninstallation, ensure that the GeneMapper® ID-X Software is
uninstalled (go to Start » Control Panel » Add or Remove Programs
and make sure it is not listed.

If it is still listed, manually uninstall the software (see “If the
GeneMapper® ID-X Software is still listed after uninstalling” on

page 42).

Check notification settings

16

1. Select P » Control Panel » User Accounts. Click Change User
Account Settings.

2. In the User Account Control Settings, drag the slider to the
bottom position Never Notify.

&‘ User Account Control Settings =

Choose when to be notified about changes to your computer

User Account Control helps prevent potentially harmful programs from making changes to your computer.

Tell me more about User Account Control settings

Always notify

]

Mewver notify

Never notify me when:

® Programs try to install software or make changes to
my computer

* Irmake changes to Windows settings

6 Mot recommended. Choose this only if you need to
use programs that are not certified for Windows 7
because they do not support User Account Control.

) oK Cancel
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Check Microsoft .NET Framework version

Check Microsoft .NET Framework version

Ensure that a version of 3.5 or later is installed on the computer:
1. Select @) » Control Panel » User Programs and Features.

2. Scroll down and determine if a version of 3.5 or later is
installed. (There may be multiple versions installed. Do not
remove any versions of the software.)

- =
Ll ||:} v Contral Panel » All Contral Panel Iterns  » Prograrms and Features

Control Panel Home "
Uninstall or change a program

MR R e s To uninstall a program, select it from the list and ther
"?_;E' Turn Windows features on or
= Organize «
=
Marme

[l

L2 Microsoft MET Framework 4 Client PlvEIFsion 35 or
55 Microsoft NET Frarmework 4 Extended - ris required
Microsoft MET Framework 4 Multi-Targging Pack

3. If a version of 3.5 or later is not installed, download Microsoft
NET Framework 4 from Microsoft.com. Ensure that the
download you select supports 32-bit (x86) or 64-bit (x64) as
appropriate for your computer.

4. Install the software.

5. After installation completes, verify the Microsoft NET
Framework 4 was successfully installed (select €§ » Control
Panel » User Programs and Features).

P

Ll ||:} v Contral Panel » All Contral Panel Iterns  » Prograrms and Features

Control Panel Home "
Uninstall or change a program

MR R e s To uninstall a program, select it from the list and ther
"?_;E' Turn Windows features on or
= Organize «
=
Marme

'—?-Microsoft MET Framework 4 Client Profile
icrosoft MET Frarmework 4 Extended
icrosoft MET Frarmework 4 hMulti-Targeting Pack

GeneMapper® ID-X Software v1.5 Installation Guide 17
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Restart the computer

Restart the computer

To activate the changes made in the previous sections, restart the
computer before installing the software.

Obtain the GeneMapper® ID-X Software host
computer name

Before you install the client GeneMapper® ID-X Software, obtain the
name of the multi-user database host computer to enable access to
the host computer from a network:

1. On the multiuser database host computer, click @ , right-click
Computer, then select Properties.

View basic information about your computer

Windows edition
Windows 7 Enterprise
Copyright © 2009 Microsoft Corporation. All rights reserved,

Service Pack1
System
Manufacturer Thermo Fisher Scientific
Rating: m Windows Experience Index
Processor: Intel(R) Core(TM) i7-4600U CPU @ 2.10GHz 2.70 GHz
Installed memory (RAM):  16.0 GB
System type: G4-bit Operating System
Pen and Teuch: Mo Pen or Touch Input is available for this Display

Thermo Fisher Scientific support

Phone number: 1.566.643.0360
Support hours: 24x7
Website: Online support

Computer name, domain, and workgroup settings
Computer name: BEDLESCAMI2 CompUter name
Full computer name: BEDLEECAMI2.ads.invitrogen.net

Computer description:

Domain: ads.invitrogen.net
2. Make a note of the computer name and enter this name when

prompted during installation of the client GeneMapper® ID-X
Software.
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General installation instructions

General installation instructions

IMPORTANT! If you use a computer platform that does not meet the
requirements listed in Installation Requirements, you may
experience difficulties during installation (new or upgrade) of
GeneMapper® ID-X Software, or the software may not function
properly, even if the installation proceeded successfully.

Before installing the GeneMapper® ID-X Software:

Review Installation Requirements.

Log in to the local computer and have Administrator privileges
when installing, un-installing, or upgrading the GeneMapper®
ID-X Software. Logging in to a network domain with
administrative privileges is not sufficient.

During installation (new or upgrade) of GeneMapper® ID-X
Software:

— Install the Full version first, then install all Client versions
which will connect to the Full version database.

— Allow the installation DVD to Autostart, or double-click
the Setup.exe file to launch the installer.

When un-installing the GeneMapper® ID-X Software, log in
using the same local user account as the one used when
installing the software and follow the un-installation message
prompts during the un-installation process to ensure clean un-
installation.

Performing a full installation

20

A full GeneMapper® ID-X Software installation:

Installs the GeneMapper /D-X software and database.

Enables the GeneMapper ID-X software to serve as the host for
multiple client computers needing access to the database.

Upgrades only: During installation, requires you to enter the
registration code for your current version of software.
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Performing a full installation

Full installation requirements

Important * DO NOT cancel an installation before the installation process is

reminders finished. If you do so, or if the installation otherwise stalls, you
may need technical support to perform an uninstall. To
uninstall, see “Uninstalling the GeneMapper® ID-X Software”
on page 42. If uninstallation fails, contact technical support.

Installing the Full GeneMapper® ID-X Software

Full installation 1. Insert the Full install disk into the CD drive.
procedure

2. On the splash screen, double-click Install GeneMapper ID-X
Application to start the installer.
In the Welcome window, click Next.

Review the installation requirements status, then click Next.

Read the release notes, then click Next.

o o  w

Click Next to install the Software to the default location. To
install the GeneMapper® ID-X Software to a drive different
from the default drive, select the destination folder:

Select a destination folder with at least 10 GB of free space,
then click Next.

IMPORTANT! If you choose an invalid destination such as A:
drive or CD-DVD ROM and click Next, an error message is
displayed saying the drive is invalid. When you click OK the
installation is stopped. To recover, click Cancel and start the
installation over again, using a valid destination folder.
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Performing a full installation

7. Read the current settings, then click Next to start the
installation.

IMPORTANT! During installation, a DOS window may open
while DOS commands execute. Do not delete, close, or click the
DOS window. If you accidentally click the DOS window, press
the Esc key to exit the window.

8. Upgrades only: When prompted, type the registration code for
your current software.

9. Inthe InstallShield Wizard Complete page, select Yes, I want to
restart my computer now, then click Finish.

When you finish the installation, proceed to Chapter 5, “Performing
Post-Installation Procedures,” on page 27.
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Performing a client installation

Performing a client installation

A client installation:

» Allows the user access to the GeneMapper ID-X software
without a database installed on the same computer.

¢ Connects to one or more database hosts for access to the data
stored in the database and saves data objects back to the
database.

» Upgrades only: During installation, requires you to enter the
registration code for your current version of software.

Client installation requirements

Important * DO NOT cancel an installation before the installation process is

reminders finished. If you do so, or if the installation otherwise stalls, you
may need technical support to perform an uninstall. To
uninstall, see “Uninstalling the GeneMapper® ID-X Software”
on page 42. If uninstallation fails, contact technical support.

» At least one full installation of the same software version must
be performed on another computer for it to act as the database
host for the client.

» Users are required to have a valid user name and password with
an account on the database host computer.

* You must obtain the name of the database host computer to
enable access to the host computer from a network: Right-click
My Computer on the database host computer, select
Properties, then select the Computer Name tab to view and
record the full computer name. You are required to enter this
name during installation (see page 18).

Installing the Client GeneMapper® ID-X Software

1. Insert the Client Install CD into the CD drive.

GeneMapper® ID-X Software v1.5 Installation Guide 23



" Chapter 4 Installing the v1.5 Software
Performing a client installation

2. On the splash screen, double-click Install GeneMapper ID-X
Client to start the installer.

. In the Welcome window, click Next.
. Review the installation requirements status, then click Next.

3
4
5. Read the release notes, then click Next.
6

. When prompted, enter the GeneMapper® ID-X Software (GM)
host (server) computer name, then click Next.

GeneMapper® ID-X Client

Enter Text
Pleage enter information in the field below.

Fravide a valid Genstapper® D= Databaze Mame below. If vou don't have the
GeneMapper® ID-< Database installed vet, Y'ou can still proceed with the client installation
and install the server later. Genetdapper® 1D-% Client requires a valid Genetd apper® 10+
Databasge in order to function properly.

[ < Back " Mest » l[ Cancel ]

7. After the installer establishes a connection with the multi-user
database computer, click OK to continue.
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Performing a client installation

8. To install the GeneMapper® ID-X Software to a drive on the
client computer other than the default drive, select the
destination folder and verify that the boot drive (drive on which
the Windows operating system is installed) contains at least
250 MB of available free space.

IMPORTANT! If you choose an invalid destination such as A:
drive or CD-DVD ROM and click Next, an error message is
displayed saying the drive is invalid. When you click OK the
installation is stopped. To recover, click Cancel and start the
installation over again, using a valid destination folder.Read the
current settings, then click Next to start the installation.

IMPORTANT! During installation, a DOS window may open
while DOS commands execute. Do not delete, close, or click the
DOS window. If you accidentally click the DOS window, press
the Esc key to exit the window.

9. Upgrades only: When prompted, type the registration code for
your current software.

10. Remove the installation CD from the CD drive.

11. In the InstallShield Wizard Complete window, select Yes, I
want to restart my computer now, then click Finish.

12. Repeat the procedure for additional client installations.

When you finish all client installations, proceed to Chapter 5,
“Performing Post-Installation Procedures,” on page 27.
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Reset file and folder permissions after installation (Client installation)

Reset file and folder permissions after installation
(Client installation)

28

The client installer specifies folder privileges at the time of the
GeneMapper® ID-X Software installation.

However, the NTFS permissions set by the system administrator
may not allow the GeneMapper® ID-X Software to access the
GeneMapper folder following installation. Before you run the
software, check the permissions to make sure that the GeneMapper®
ID-X Software can access the GeneMapper folder.

If you do not have the required permissions, you may see a “can't
access file” or “..\ GeneMapper_Preferences (Access is denied)”
error message when using the software. To set the privileges
manually, either before running the software or in the event of an
error message:

1. Right-click the AppliedBiosystems folder.
2. Select Properties, then click the Security tab.
3. In the top pane, select Users.

4. Click Edit.
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Reset antivirus, firewall, and network computer settings

5. In the bottom pane, select Full Control.

| Applied Biosystemns Properties @

| General I Sharing| Security | Previous Versions Eustomize|

Object name:  C:\Applied Biozystems

Group or user names:
5, Authenticated Users
5L SYSTEM
%}Administrators [OPTIPLER-<E-S%" Administrators]
.33, Uszers [OPTIPLEX-XE-S%\U zers)

To change permiszions, click Edit.

Permizzions for Uzers Allow Deny
Full cantral v it
Madify v

Read & execute

m

Lizt folder contents
Read [
"wirite i 2

For special permissions of advanced settings,
click Advanced.

Leam about sccess control and permissions

QK ][ Cancel ] Apply

Reset antivirus, firewall, and network computer
settings

Reset the antivirus, firewall, and network settings you changed for
installation.
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Register the GeneMapper® ID-X Software

Register the GeneMapper® ID-X Software the first time you start the
software on each computer. The registration code is on the
registration card packaged with the software.

1. Click @ » All Programs » Applied Biosystems »
GeneMapper » GeneMapper ID-X.

2. Complete the Registration dialog box:

o' GeneMapper® ID-X

Product Registration

‘four Mame: |
Organization:

Registration Code:

3. Click OK.
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Logging into GeneMapper® ID-X after installation

1. Ifthe Login dialog box is not displayed in the desktop, Click
» All Programs » Applied Biosystems »
GeneMapper » GeneMapper ID-X.

2. In the Login to GeneMapper ID-X dialog box, enter or select
“gmidx” as the administrator account user name and the
temporary password, “password”, then click OK.

3. If prompted, specify a new password. Keep a record of the new
password. Click OK.

Note: The gmidx account requires you to set a new password

when you log in for the first time. If you follow this procedure
after first log in, the passwords for the accounts listed may be

different from the passwords listed in this guide.

IMPORTANT! Do not lose the password for the gmidx account.
We cannot retrieve these passwords.

4. Review the license agreement and product warranty, then click
Accept.
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Connecting to a new host

Connecting to a new host

32

If you install more than one multi-user database computer, any
v1.5 client computer can connect to any of the databases if the client
is on the same network as the database computers.

Note: All client computers connecting to multi-user database
computers must be running the same version of GeneMapper /D-X
Software.

IMPORTANT! Do not attempt to connect a v1.4 client (or any earlier
version) to a v1.5 database. Doing so will lock the database and will
require assistance from a service representative to unlock.

Users must set up separate user accounts on each multi-user database
computer that they wish to access.

Note: For detailed information on setting up user accounts, see the
GeneMapper® ID-X Software Administrator’s Guide.

To make the multi-user database computers available to client
computers, perform the following steps for each client computer:

1. Click New Host in the Login to GeneMapper /D-X dialog box.

#* Login to GeneMapper® ID-X E|
User Mame |gmid: v
Password:
Database Host: | sgsngem10s ¥

[ Delete Host ][ Diefault Host ] [ ok ][ Exit ][ Help ]

2. Complete the information in the New Host dialog box:
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Connecting to a new host

o New Host 3

Enter nev GeneMapper® I0-K host information:

Machine Type: Stand-alone v

a. In the Host Name field, enter the full computer name or
IP address of the multi-user database host you want to
access. If the GeneMapper® ID-X Software cannot connect
to the database host, the error message ““You have entered
an invalid host” is displayed. Click OK to exit, then re-
enter the database host information.

b. Select the applicable machine type.
c. Click OK.

The Login window is updated to include the name of the new
database host. The User Name list reflects the user accounts on
the new database host. See the GeneMapper® ID-X Software
Administrator’s Guide for additional information.
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Checking concurrent access settings for client
computers

If your configuration includes client computers:
1. Open a project on the computer containing the database.

2. Open the same project on a client computer.

If a message is displayed on the client computer indicating the
the project is read-only, concurrent access settings are properly
specified and no further action is required.

3. Ifno message is displayed on the client computer, do the
following:

a. Contact your network administrator and ask if “Multicast”
functionality is enabled on the network.

b. On the computer containing the database, navigate to
x:\AppliedBiosystems\GeneMapperID-X\service\bin
folder.

c. If Multicast functionality is enabled, double-click
SwitchToMulticast.exe.

If Multicast functionality is not enabled, double-click
SwitchToUnicast.exe.

4. Repeat step 1 and step 2 and ensure that a message is displayed
on the client computer indicating the project is read-only.
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Logging out of the GeneMapper® ID-X Software

You can close the GeneMapper® ID-X Software by:
» Selecting File » Logout.
* Selecting File » Exit.
* Clicking E3 (Close).

When you log out of the GeneMapper® ID-X Software with a project
that has unsaved changes, the software prompts you to save or
discard the changes you made since the last time you updated the
project.

Save Project

If you used the File » Logout command, the login window re-opens
after you select either Yes or No. The GeneMapper /D-X Software
closes completely if you use either File » Exit or 3 (Close).
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Additional post-installation tasks

Importing  Select Tools » GeneMapper ID-X Manager. Then in the
application data GeneMapper /D-X Manager window, click each tab to import the
corresponding objects into GeneMapper® ID-X Software.

Creating user For information on creating user accounts and configuring the
accounts and  Security Manager, Audit Manager, and E-Signature Administrator,
configuring see the GeneMapper® ID-X Software Administrator’s Guide.
administrative
functions
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ﬁ Troubleshooting
)

the Installation

This appendix covers:
B Symptoms and causes . . ...t 38 H
B Troubleshootingtasks .......... ... ... ... ... .... 42
B Troubleshootingtools .......... ... ... ... ........ 55
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Symptoms and causes

Symptom Possible cause Action
ORA-12528 and ORA-12541 32-bit computers only: Virtual See Check virtual memory
Oracle® errors displayed during | memory setting needs settings (32-bit only) on
installation adjustment. page 51.

Problem with Oracle® software | Contact Technical Support.
installation.

POWS\system32\cmd.exe ﬂ J

Release 11.2.8.1.8 Production on Thu May 17 14:19:19 2812
{c> 1982, 2818, Oracle. All rights reserved.

: TH8:1listener: all appropriate instances are blocking new connections

System32%cmd.exe
F—Name =

SOL*Plus: Release 11.2.0.1.0 Production on Wed May 2 12:01:16 2012

Copyright (c) 1982, 2010, Oracle. All rights reserved.

JORA-12541: TNS:no listener

lEnter user-name: _
i

“GeneMapper® ID-X software Incorrect Microsoft® NET 1. Cancel the installation.
requires Microsoft .NET Framework version 2. Install the required version.
Framework 3.5 or greater. You See Check Microsoft NET

can download from Microsoft.” Framework version on

page 17.
3. Start the installation again.
GeneMapper® /0-X Software Uninstallation of the previous Uninstall the software. See
will not start after installation version of GeneMapper® /0-X Uninstalling the GeneMapper®
Software failed. ID-X Software on page 42.
Note: In most cases, If the problem persists, contact

uninstallation should succeed. | Technical Support.
However, third-party software,

firewall interference, and other

situations may interfere with

successful uninstallation.
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Symptom

Possible cause

Action

“No databases found” message

Network security settings are
preventing communication
between the user interface and
the Oracle® database.

Modify network security
settings. See Enable
communication with port 1521
on page 43.

Virtual network adapters are
enabled.

Disable virtual network
adapters.

If the problem persists, contact
Technical Support.

“The database connection has
been lost. Please restart the
application. This message may
appear multiple times.”
message

Network communication is
interrupted.

Wireless network in use.

Restart the software.

Restart Oracle services (see
Restart Oracle services on

page 47).

Use a cable-based network
system, such as a CAT5e
network, with plug-in Network
Interface Controller (NIC) cards.

Full installation regularly loses
connection with the database

Client installation “cannot
access file” or “.\
GeneMapper_Preferences
(Access is denied)” message

Anti-virus software is

interfering with communication.

Use less restrictive anti-virus
settings.

Disable, replace, or remove the
anti-virus software.

Use a cable-based network
system, such as a CAT5e
network, with plug-in Network
Interface Controller (NIC) cards.

Unstable network connections.

File and folder permissions are
not set correctly on the client
computer.

Contact your network
administrator.

Use a cable-based network
system, such as a CAT5e
network, with plug-in Network
Interface Controller (NIC) cards.

Set permissions. See Reset file

and folder permissions after
installation (Client installation)
on page 28.
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Symptom

Possible cause

Action

Client installation regularly
loses connection with the
database, but full installation
does not lose connection

Unstable network connections.

Contact your network
administrator.

Disk space message is
displayed when you start the
software

The computer has limited
available disk space.

If possible, archive then delete
data from the database.

Use the Database Dashboard
utility to compress the
database.

Note: You may see a
discrepancy between the space
used in the Database
Dashboard » GeneMapper

IDX » Projects Statistics and
the available free space. This
discrepancy is caused when you
delete projects from the
GeneMapper® /D-X Software.

Version error displayed when
you import a panel file (this
message differs from the
message displayed in earlier
versions of the software)

GeneMapper® ID-X Error

[

P
'.0' "Version' incorrect or missing. Offending line #1

The version text in the panel .txt
file is not present.

[ AmpFLSTR_Panels_v#4.txt - Notepad

File Fdit Format View HE|DI

wversion GMID-» w 1.4

Lo e w1 MTCROSATELLITE
Chemistry Kit  AMpFLSTR_Panels_wix
Panel Profiler_vl.2x null

Edit the panel .txt file to include
the text shown in the figure.

Cannot access deleted audit
records

Restore the audit records.

1. In the Project window, select
Admin » Audit
Manager » Report.

2. Log in to the Audit Manager.

3. In the Audit History Viewer,
File » Edit Query, leave the
default settings, then click
OK.

4. Select File » Execute Query.

40
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Troubleshooting tasks

Canceling an installation

DO NOT cancel an installation before the installation process is
finished. If you do so, or if the installation otherwise stalls, you may
need technical support to perform an uninstall. To uninstall, see
“Uninstalling the GeneMapper® ID-X Software” on page 42. If
uninstallation fails, contact technical support.

General installation solutions

Obtaining the
installation log file

Note: You may need to send the GeneMapper /D-X install and MSI
log files to Technical Support if the troubleshooting procedures in
this appendix do not solve the installation problem.

If you have trouble installing the GeneMapper® ID-X Software on
your computer:

Task See page
1. Obtain the installation log file. 41
2. If necessary, uninstall the software. 42
3. If necessary, have a knowledgeable technician run the 50
Fix It utility.

To obtain the installation log file, go to:
x:{installdir}\AppliedBiosystems\GeneMapper ID-X where x is
the drive on which the GeneMapper /D-X Software is installed and
{installdir} is the user-selected installation path.

* You will find 2 logs for the full installation:
— GMIDXInstall.log
— GMIDX_MSIl.log

* You will find 2 logs for the client installation:
— GMIDXClientlInstall.log
— GMIDXClient_MSI.log
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Uninstalling the 1. Restart the computer and log on using a local computer
GeneMapper® ID- administrator account (see Check user access on page 12).

X Software 2. Ensure that no programs or applications are running.
3. Disable any antivirus software (including antimalware
software).

4. Select @) » Control Panel » Uninstall a Program. Select
GeneMapper® ID-X Software, then click Uninstall.

5. Restart the computer and log on using a local computer
administrator account.

6. Confirm that the software has been uninstalled: select
€ » Control Panel » Uninstall a Program. If GeneMapper®
ID-X Software is still listed, go to If the GeneMapper® ID-X
Software is still listed after uninstalling on page 42 below.

If the 1. Ensure antivirus/antimalware software is disabled.
®
GeneMappe_r ID_' Note: In some instances, the antivirus/antimalware software is
X SOftW_are is still automatically enabled, so you must ensure it is disabled more
listed after than one time in the procedure.

uninstallin
g 2. Confirm the Virtual Memory settings are correct (Check virtual

memory settings (32-bit only) on page 51).
3. Run the Remove Oracle utility:

a. Insert the GeneMapper® ID-X Software Full or Full
Upgrade Installation DVD in the computer DVD drive,
right-click on the drive icon, then select Explore.

b. Navigate to Utilities » RemoveOracle.exe.
c. Copy RemoveOracle.exe to the desktop.

d. Double-click RemoveOracle.exe (a black box appears for a
few seconds and disappears).

4. Navigate to and delete the entire x:\AppliedBiosystems folder.

5. Restart the computer and log on using a local computer
administrator account.
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The GeneMapper® ID-X Software uses port 1521 to communicate
between the user interface and the Oracle database via the TCP
Internet Protocol and TNS Names. On most computers, this port is
enabled automatically during installation.

However, if the software does not start or a “No databases found”
message is displayed after installation, modify settings to enable
communication with port 1521.

IMPORTANT! In addition to Windows security settings, some third-
party anti-virus or firewall applications may affect port 1521. If you
are running, third-party anti-virus or firewall applications, modify
settings for those applications to enable communication with port
1521.

1. Select @) » Control Panel » System and Security » Windows
Firewall. Click Advanced Settings.

Control Panel Home

Allow a program or feature
through Windows Firewall

¥ Change notification settings

“_‘_," Turn Windows Firewall on or
off

#%)_Restora-del

"ip" Advanced settings

EShioot my network

Action Center

Metwork and Sharing Center

===
@@vﬁ‘ ¥ Eantra] Banel Cv2 Al Control Parel Terrs w2 Wiridovrs Eirewall + 43| Search ControtPansl P
(7]

Help protect your computer with Windows Firewall

Windows Firewall can help prevent hackers or malicious software from gaining access to your computer
through the Internet or a network.
How does a firewall help protect my computer?

What are network locations?

Update your Firewall settings

Windows Firewall is not using the recommended

: %) Use recommended settings
settings to protect your computer. | = g I

What are the recommended settings?

. @' Home or work (private) networks Connected (&)

Metworks at home or work where you know and trust the people and devices on the network

Windows Firewall state: Off

Incoming cennections: Block all connections to programs that are not on the
list of allowed programs

Active home or work (private) networks: L:L applera.net

Motification state: Notify me when Windows Firewall blocks a new

program

. @' Public networks

Not Connected V
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2. Inthe Windows Firewall with Advanced Security window, click

Inbound Rules.

& Windows Firewall with Advanced Security
File

Sl d

Action  View Help

=

Windows Firewall with Advanced Security on L...

-

@ “Windous Firewsll with
51 Inbound Rules
CQutbound Rules

5 . ﬂ ‘windows Firewall with Advanced Security
2h Connection Secur

- B Monitoring

m

Orserview
Domain Profile

@ windaws Firewall is an.

Actions
Windows Firewall with Advanced Security on Local Computer
| Import Policy...
43| Export Policy...
Restore Default Policy
Diagnose f Repair

Wigan
O Inbound connections that do not match a il
_ |G Refresh
@ Outbound connections that do not match a r
D Properties
I.:Tnvate Profile is Active Help
4 windows Firewall is off.
Fublic Profile
B windaws Firewall is aff. -
4 i N i | b
3. Click New Rule.
& Windows Firewall with Advanced Security =
File Action ‘iew Help
ol 2] 53 HEY
B Windows Firewall with BTN TG Actions
Inbound Rul
&3 Inbound Rules Narne o

Outbound Rules

& Connection Secur @Akamai MetSession Interface
oy

@Akamai MetSession Interface

@Akamai MetSession Interface

@Akamai MetSession Interface

@ CyberlLink PowerDVD DX

@CyberLink PowverDtD DX Resident Progra...
@ocom

.GeneMapperID)(

@HP BPT Rernote Agent

@HP BPT Rernote Agent

@Microsoft Office Qutlook
.BranchCache Content Retrieval (HTTP-In)

B
-

- B Monitoring

@ EranchCache Hosted Cache Server (HTT,

ilter by Profile
Filter by State
Filter by Group
Wigan

Refresh

B

Export List..,

S

Help

44
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4. Select Port, then click Next.

ﬂ Mew Inbound Rule Wizard

Rule Type

Select the type of firewall rule to create.

Steps:

@ Rule Type wihat type of rule would pou like to create?
@ Frotocol and Parts

@ Action ) Program

@ Profile Rule that contra

@ Mame

Fiule that controls connections for a TCP or UDP port.

BranchCache - Content Retrieval [Jsez HTTF]

Rule that controls connections for a Windows experience.

() Custom
Customn rule.

< Back Cancel

5. Select TCP, then type 1521 in the Specific Local Ports, then click
Next.

ﬂ Mew Inbound Rule Wizard
Protocol and Ports
Specify the protocols and ports to which this rule applies.

Steps:

& Fule Type Does this rule apply to TCP or UDP?

Praotocol and Ports
Action

Frafile

@ Mame

T80, 443, 5000-5010

< Back H et > ] [ Canc
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6. In the Action page, select Allow the connection, then click
Next.

ﬁ MNew Inbound Rule Wizard
Action
Specify the action to be taken when a connection matches the conditions specified in the ule.

Steps:

Rule Type ‘what action should be taken when a connection matches the specified conditions?

Fratocol and Paorts

@ Allow the connection

2 T Thiz includes connections that are protected with IPzec az well az those are not,
Frafile
! Allow the conneclion FSeCUre
M ame

Thiz includes only connections that have been authenticated by uzing IPsec. Connections
will be gecured using the settings in IPsec properties and rules in the Connection Security
Rule node.

Block the connection

| < Back | [ Mest > | | Cancel

7. In the Profile page, leave the default settings selected, then click
Next.

ﬁ Mew Inbound Rule Wizard
Profile

Specify the profiles for which this rule applies.

Steps:
Rule Type when does this rule apply?
Pratocol and Ports

s Action [¥] Domain

y Profils Applies when a computer iz connected to its corporate domain,
Hame [¥] Private

Applies when a computer iz connected to a private network location.
[¥] Public

Applies when a computer iz connected to a public network location.

| < Back | | Mest » | [ Cance

8. In the Name page, type GeneMapper IDX, then click Finish.
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7 . D
roubleshooting tasks =

n MNew Inbound Rule Wizard

Name

Specify the name and description of this rule.

Steps:
@ Rule Type

Fratocol and Ports

&

# Action

@ Profile S
Genekdapper 103

@ Mame

Deszcription [optional]:

| < Back “ Einizh ] I Cancel

The Inbound Rules List is displayed with GeneMapper IDX
added as a rule. The rule should be enabled by default
(indicated by the presence of the Disable Rule command).

& Windows Firewall with Advanced Security
File Action ‘iew Help

L ale A1 ) NESN 7|

B Windows Firewall with BTN TG Actions

I hbound Rues Mame || Inbaund Rules
B8 Outbound Rules E
H% Connection Secur

'ﬂ'GeneMapperID){ m ﬂ Mew Rule..,

» Bl Manitaring @Akamai MetSession Interface T Filter by Profile

@Akamai MetSession Interface F Filter by S

@Akamai MetSession Interface llker by State
'

(@ 2kamai NetSession Interface Filter by Group

(@ Cyberlink PowerDVD D Wiew
@CyberLlnk PowverDtD DX Resident Progra... & Refresh
@ocom .

@ GeneMapperIDix [z Beportlist.

@ HP BPT Remate Agent Hel

@HP BPT Rernote Agent

U
@MicrosoftOf‘ficeOutlook ( GeneMapper IDX
‘BranchCache Content Retrieval (HTTP-In) y & Disable Rule
Mrn o~ o, e o — i
4 m. | U | I T 3

9. If Enable Rule is displayed instead of Disable Rule, click Enable
Rule.

Restart Oracle If a “The database connection has been lost” message is displayed,
services restart Oracle services using a .bat file or manually.
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Troubleshooting tasks

Restarting with a .bat file
1. On the Full installer DVD, navigate to the Utilities folder.

2. Double-click ServicesRestart.bat. (You can also copy the file to
your hard disk and start the .bat file from your hard drive.)

The following window is displayed for ~2 minutes as the
services restart.

C:\WINDOWS\system32\cmd.exe -0 x

Documents and SettingsssailusjssDesktop’net stop Oraclel FAGMIDHTHEListener
Oraclel FAGMIDETHSL ENEY ruice is stopping.
Oraclel FAGHIDXTHSListener service was stopped successfully.

Documents and Settingshsail Desktoprnet stop OracleMISRecoveryService
OracleMISRecoveryService s ce 1 topping.
OracleMISRecoveryService service w stopped successfully.

Documents and Settingsssail “Desktop>net stop OracleServicelFA
OracleServicelFA service i ing.....

3. When the window closes, start the GeneMapper® ID-X
Software.
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Restarting manually

1. Go to Start » Control » Panel » Administrative
Services » Services.

2. In the Services screen, right-click the following services, then
select Restart:
¢ OracleIFAGMIDXTNSListener
® OracleMTSRecoveryService
e OracleServicelFA

Services (Local)

OracleIFAGMIDXTNSListener MName Description Status Startup Type Log On A
%Neh\'ork Access Protection Agent Allowws win. .. Manual Local Syst

Ston ﬂ__'E SEWiEE_ %Neh\'ork Connections Manages a... Started Manual Local Syst

Restart the service ) )
%Neh\'ork DDE Provides m... Disabled Local Syst
%Neh\'ork DDE DSDM ManagesD... Disabled Local Syst
%Neh\'ork Location Awareness (MLA) Collects an... Started Manual Local Syst
%Neh\'ork Provisioning Service Manages X... Manual Local Syst
%NT LM Security Support Provider Provides .., Manual Local Syst
%OZFLASH Started Automatic Local Syst
%Ofﬁce Source Engine Savesinst... Manual Local Syst

pent Manual Local Syst
Started Automatic Local Sys{

Disabled Local Syst

Stop Started Automatic Local Syst

CradeServicelFA Started Automatic Local Syst
Performance Logs an Collects pe... Manual Metwork &
%Plug and Play Enzblesa c... Started Automatic Local Syst
%Pml Driver HPZ12 All Tasks 3 Started Automatic Local Sery
%Portable Media Serial Retrieves t... Manuzl Local Syst
%Pnnt Spooler Refresh Loads files ... Started Automatic Local Syst
%Protectad Storage Properties Provides pr... Started Automatic Local Syst
%QDS RSP Provides ... Manual Local Syst
%Remme Arcess Auto Help Creates a ... Manuzl Local Syst
%Remme Access Connection Manager Createz & ... Started Manual Local Syst
%Remule Deskiop Help Session Manager Manages &... Manual Local Syst
%Remule Procedure Call (RPC) Provides th.., Started Automatic Metwork &
%Remote Procedure Call (RPC) Locator Manages t... Manual Metwork &
%Remote Registry Ensblesre... Started Automatic Local Sery
%Removable Storage Manual Local Syst

3. Ensure the Startup Type is set to Automatic for each service. If it
is not, right-click a service, then select Automatic for Startup

Type.
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OraclelFAGMIDXTNSListener Properties (Local Comput... [ |[X]

General |Log On || Recovery || Dependencies

Service name: OraclelFAGMIDXTNS Listener
Display name: OraclelFAGMIDXTNS Listener
Description:

Path to executable:
C\AppliedBiosystems OracleGMIDXMBINYTNSLSNR

Startup type: Automatic LY
Manual
Service status: Disabled
You can specify the start parameters that apply when you start the service
from here.
[ oK ] [ Cancel ]

4. Start the GeneMapper® ID-X Software.

Running Run these utilities under only the following conditions:

- ® - -
Microsoft F'X it * You have attempted the uninstall procedure using the
utilities Add/Remove Program uninstall option,

and

+ The GeneMapper® ID-X Software files were not removed or
were only partially removed.

1. Go to http://support2.microsoft.com/fixit/.

2. Select Windows, then select Install or upgrade software or
hardware.

3. Scroll down to Fix problems that programs cannot be
installed or uninstalled, then click Run Now.

4. Follow the instructions in the wizard. When prompted, select
Detect problems and let me select the fixes to apply, then
select Uninstall.
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5. Select GeneMapper® ID-X Software, then click Yes when
asked if you want to fix the problem.

6. A dialog will come up asking if you want to try to fix it

Check virtual 1. On the desktop, right-click My Computer, then click Advanced
memory settings System Settings.
(32-bit only)

=S R =
S~
uu |j1?i » Control Panel » All Control Panelltems » Systern - |+,| | Search Control Panel P |
@ -
Control Panel Home 5 s . i
View basic information about your computer
B Device Manager Windows edition
¥ Remote settings Windows 7 Professional
) System protection Copyright © 2000 Microsoft Corporation. All rights reserved.
@ Advanced system settings Service Pack 1
Get more features with a new edition of Windows 7
P
System
Manufacturer: Dell =
Model: Optiplex XE
Rating: a Windows Experience Index
Processor: Intel(R) Core(TM)2 Duo CPU  ES400 @ 3.00GHz 3.00 GHz
Installed memory (RAM):  4.00 GB (3.25 GB usable)
System type: 32-bit Operating System
Pen and Touch: MNe Pen or Touch Input is available for this Display
Dell support
Website: Online support
SR Computer name, domain, and workgroup settings i
Actioi Contes Computer name: OPTIPLEX-XE-5V :‘f‘g'Chamge settings
IS Full computer name: OPTIPLEX-XE-5V
:_::;Jsrmancelnfurmatmn it Computer description: Optiplex XE Series Instrument & Application Computer
Workgroup: 'WORKGROUP -
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2. In the System Properties dialog box, click Settings in the
Performance section.

Systern Properties @
Computer Mame Advanced | Spstem Protection | Remaote

“Y'ou musgt be logged on as an Administrator to make most of these changes.

Perfarmance

Wisual effects, processor scheduling, memary usage, and virtual memany

Uszer Profiles

Desklop settings related to your logon

Startup and Recovery

Sustem startup, system failure, and debugging information

Environment ' ariables...

[ QK ][ Cancel ] Apply

3. Click the Advanced tab, then click Change in the Virtual
Memory section.

Performance Cptions @

wisual Effects | Advanced | Data Execution Prevention

Processor scheduling

Choose how ko allocate processor resources,
Adjust For best performance of

@) Programs () Background services

Wirkual memary

A paging file is an area on the hard disk that Windows uses as

if it were RAM,
Tatal paging file size for all drives: 3325 MB
OF ] [ Cancel ] Apply
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4. In the Virtual Memory dialog box, deselect the Automatically
Manage paging file size for all drives check box. Select the C:
drive. Click the Custom size radio button. Specify 2046 MB for
initial and 4092 for maximum size.

IMPORTANT! The exact Maximum Size necessary may depend
on your computer configuration. If installation still fails when
using these values, or if Oracle® ORA-12528 and ORA-12541
errors are displayed, increase the Maximum size to at least 2X
the physical memory (the minimum required for the installation
of Oracle® software) up to the value shown for Space Available,
then repeat the installation. To determine the physical memory
for your computer, right-click My Computer on the desktop,
select Properties, then look for the RAM value on the General
tab. Example: If the physical memory is 3.0 GB RAM, set the
Maximum Size to 6000.

Wirtual Memory @

|| Automatically manage paging file size for all drives

Paging FleEEefores
Drive [Volume Label Paging File Size {ME)

(s 05 Syshem managed
Di  [AB 5w B DATA] Hane

5 [AB Service] Mone
Selected drive: C: [05]

Space available:

2046

Initial size {ME):

409z

aximum size (ME):

() Mo paging file Set

Total paging file size for all drives
Minimurn allowed: 16 MB
Recommended: 4937 MB
Currently allocated: 3325 MB

[ Ok ] [ Cancel

5. Click Set, then click OK.

These settings are not activated until you restart the computer.

Restart the computer, then check virtual memory settings again to
ensure that the new settings are activated.
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Troubleshooting tools

Complete the Troubleshooting Checklist and Interdepartment Forms
before contacting Technical Support for assistance.

Checklist

Table 6 Troubleshooting Checklist

Check Information for Technical Support

Summarize the problem:

Can you repeat the problem?

If yes, list the steps that you perform:

No oD~

Personnel that you have contacted:

[ Field Applications Specialist
1 Field Service Engineer

1A Technical Support

[ Sales Representative

[ Order Administration

[ Other

Computer specifications:

e Operating system:

e \ersion:

* Processor:

e Memory:

e Hard disk space:

¢ Hard disk configuration:

54 GeneMapper® ID-X Software v1.5 Installation Guide



Appendix B Troubleshooting the Installation n
Troubleshooting tools <

Check Information for Technical Support

Software installed:

1 GeneMapper ID-X Software version:
[ Other software:

Computer login information:
e User privileges:
¢ Local or networked domain:

Software configuration installed:

1 Stand-alone
d Multi-user database

Instrument and instrument computer information:

¢ Model:

e Data Collection Software version:
e Status of Data Collection services:
e Other software:

e Capillary length:

e Capillary lot number:

e Run module:

¢ Dye set:

Chemistry kit or reagent, with version number:

Be prepared to send to Technical Support:

¢ |[nstallation log file (page 41)

e Exported panels

¢ Exported bins

e Exported size standard definition

¢ Exported analysis method

e Sample (.fsa) files

¢ GMIDXInstall.log or GMIDXClientInstall.log
¢ PanellmportLog.txt

¢ Printed results
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Interdepartmental forms

56

Answering questions in the following forms helps manage complex
troubleshooting procedures. Your answers will be shared among
support groups, product groups and software development teams.

To address any issues that may arise when installing or running the
software, please answer the applicable list of questions, and collect
the necessary files before contacting Technical Support.
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For installation Collect the following files and complete the questions below:

ISSUCS  For full installation:

* GMIDXInstall.log
* GMIDX_MSI.log

For client installation:
* GMIDXClientInstall.log
* GMIDXClient_MSI.log

Do the computer and operating system meet the required computer specifications? (See Chapter 2,
“Installation Requirements,” on page 5.)
List any potential discrepancies.

Did you receive any error messages or alerts? If so, what did they say? (if possible, take screen
captures.) At what point during the installation process did these errors/alerts occur?

How many installation attempts have you tried?

Are you logged in to the local computer?

Is the TCP/IP configured?

Do you have administrative privileges?

Is this setup stand-alone, networked, or connected to a Genetic Analyzer?
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For post-
installation
related issues

Do the computer and operating system meet the required computer specifications? (See Chapter 2,

“Installation Requirements,” on page 5.)
List any potential discrepancies.

Problem description:

Did you receive any error messages or alerts? If so, what did they say? (If possible, take screen
captures.) At what point did these errors/alerts occur?

Is the problem reproducible?

Steps taken prior to encountering or to reproduce the problem:

1.

58
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Client installation

Data Collection
Software

Full installation

Genetic analyzer

GMID
GMID-X

Local area
network

Multi-user
database host
computer

Glossary of Terms

A computer installed with the GeneMapper® ID-X Software only
(software with no database). A client installation computer connects
to a full installation computer to access the multi-user database.

The software on the Data Collection computer that controls the
Genetic Analyzer instrument and generates the .fsa or .hid (3500)
sample files.

A computer installed with both the multi-user database and
GeneMapper /D-X Software.

A full installation computer can be part of a multi-user database
configuration, or it can be a stand-alone computer having no
interaction with other computers.

The capillary electrophoresis instrument, controlled by the Data
Collection Software, which generates .fsa or .hid sample files (.hid
on the 3500).

Abbreviation for GeneMapper® ID Software.
Abbreviation for GeneMapper® ID-X Software.

A communications network that serves users within a confined
geographical area.

A computer on which data is stored on a central, multi-user database.
Commonly referred to as the host computer, from which other client
computers (computers without a database) can access, analyze, and
share data.
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Documentation and support

Related documentation

The following related documents are shipped with the system:

Document Part number Description

GeneMapper® ID-X Software | 100031701 Explains how to set up the software, set up a

Version 1.5 Getting Started project, and analyze the example data provided

Guide — Basic Features with the GeneMapper® ID-X Software.

GeneMapper® ID-X Software | 100031702 Provides an easy-to-follow workflow for using

Version 1.5 Quick Reference basic system features.

Card — Basic Features

GeneMapper® ID-X Software | 100031704 Explains how to set up the software for mixture

Version 1.5 Getting Started analysis and analyze the example data

Guide — Mixture Analysis provided with the GeneMapper ID-X Software.

Tool

GeneMapper® ID-X Software | 100031705 Provides an easy-to-follow workflow for using

Version 1.5 Quick Reference the mixture analysis tool.

Card — Mixture Analysis Tool

GeneMapper® ID-X Software | 100031707 Describes process quality values (PQVs) and

Version 1.5 Reference Guide algorithms.

GeneMapper® ID-X Software | 100031703 Describes how to configure the administrative

Version 1.5 Administrator’s features of the software, maintain the

Guide GeneMapper® ID-X Software and database
dashboard software, and use the
command-line interface.

GeneMapper® ID-X Software | 100031709 Describes command line interface commands

Version 1.5 Integration User that can be scripted and used to automate

Bulletin GeneMapper® ID-X Software operations.
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How to obtain support

For HID support:

* In the United States and Canada — send an email to
HIDTechSupport@lifetech.com, or call 888-821-4443 option 1.

* OQutside the United States and Canada — contact your local
support office.

For the latest services and support information for all locations, go
to:

www.lifetechnologies.com/support

At the web site, you can:

» Access worldwide telephone and fax numbers to contact
Technical Support and Sales facilities.

» Search through frequently asked questions (FAQs).
* Submit a question directly to Technical Support.

» Search for user documents, Material Safety Data Sheets
(MSDSs), vector maps and sequences, application notes,
formulations, handbooks, certificates of analysis, citations, and
other product support documents.

* Download .pdf documents.

* Obtain information about customer training.

Limited product warranty

Life Technologies Corporation and/or its affiliate(s) warrant their
products as set forth in the Life Technologies’ General Terms and
Conditions of Sale found on Life Technologies’ website at
www.lifetechnologies.com/termsandconditions. If you have any
questions, please contact Life Technologies at
www.lifetechnologies.com/support.
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